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O BJ E CT IV E S
 To learn to evaluate various design strategies and upgrades to the shoebox model
 To identify the performance metrics, tools and related performance goals for your project
 To learn to apply various iterative analysis techniques for optimizing the thermal envelope
 To learn a parametric analysis methodology for design optimization
 To develop an analytical approach to aid in determining the optimal solution

Introduction
This exercise guides you in continuing to work with your “shoebox” model, as a preliminary energy model for your
project. The shoebox energy model allows for optimizing design requirements before the building design has been
determined, and can be used to inform early design decisions, e.g., to optimize building envelope materials and
specifications. In this exercise you will be asked to develop a parametric analysis plan for optimization of your thermal
envelope and to make individual assignments to each person on your team. You will complete the analyses using the
“Zero+ Parametric Analysis Data Manager” Excel workbook provided. You can download it from the course Moodle
site.
As before you should first verify that your model is a close approximation of the proposed design problem. I.E.,
verify that the floor area, no. of stories, wall area and orientation are accurate based on the initial project you chose
for your study. Make any needed corrections to your shoebox and re-run the IES room identification tool. Check the
Building Properties Settings and make sure that the location is Mpls./St. Paul and the building type is set according
to your project type. Check the default building construction settings to see if they are as you set them previously. If
not, reset them now and save them. Save the Building Settings and select Room Properties. If your model requests
you to define them again, do so now. You can click either no or yes depending on whether you have assigned room
names to your model. If you have, then click “Yes.” Make sure that all of the rooms are properly identified. Clean
up the geometry in your model as needed to accomplish this. Check to see that any surrounding structures, exterior
shading devises, trees or other non-room geometry are properly designated as shading using the Select Groups tool.
(Note: If you are not using Sketchup Pro, you will not be able to export shading objects into IES, but you can draw
them in IES using the ModelIt tool. See IES VE Help for instructions on how to do this.) After you have done this,
proceed to the next set of steps.

As you perform the following steps, note that:

This symbol is your prompt to take an action in Google Sketchup.

This symbol is your prompt to take an action in IES <VE>.

This symbol is your prompt to take an action in Microsoft Excel.
You will be running all three of these programs while completing this exercise.
REMEMBER TO SAVE OFTEN!
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Exercise Two - Optimizing the Envelope:
STEP 1:

Together with your teammate(s), you should plan a series of analyses that you wish to
perform using your shoebox model in order to optimize the properties of your thermal
envelope. It is always best to begin with a plan in mind. Don’t worry if you are not sure about
all of the things you want to analyze right at first. Just get something down in writing so you
can begin to prioritize and make assignments within your team. This plan should include at
least one of each of the basic types of analysis we have discussed in class for every person on
your team (e.g., if you have two people on your team then select two of each type of analysis;
if three people, then three of every type):
1) “What if..?” analysis
2) “Apply Strategy” analysis
3) Parametric Analysis (using the single variable method)

You may find the “Zero+ Parametric Data Manager” useful for this purpose. Download it from the
Moodle Site.
For your Plan you might consider:
•
•
•
•

•
•
•

What if the building were shaded on the south?
What if the wall insulating properties were doubled?
Application of Overhangs on South Windows
Application of Passive Solar Heating Strategy
Parametric study of wall u-values
Parametric study of window u-values
Parametric Study of Building Rotation

•
•
•
•
•
•
•

What if the building were made 10% smaller?
What if the Window area reduced (or increased) by x %?
Application of “Superinsulated” envelope strategy
Application of natural ventilation strategy
Parametric study of roof u-values
Parametric study of exterior solar absorptance
Parametric Study of Building Rotation

Determine what you will change in your model in order to simulate that condition or set of
conditions. For the Parametric studies, you will need to select a min. and maximum value for the
variable you have chosen and the total number of iterations or simulations you are going to
include in your study. E.g., if you are optimizing wall thermal insulation (u-values) you might set
the maximum (worst) u-value at 0.10 (R10) and the minimum (best) at 0.017 (R60) and the
number of iterations at 10. This will establish the various values for each iteration of the
optimization study. Repeat this process as many times as necessary until you have established
parameters for all of the analyses in your plan.
Assign 3 of the analyses in your plan to each team member and proceed to run your individual
analyses. After you have completed the analyses assigned to you you will review all of the results
you obtained together as a team. You are free to work together or separately in running your
simulations, but you will be responsible for submitting the results of your studies individually.
Note: Before going any further you should now open up the Excel workbook entitled:
“2011-WBA-Parametric-Data-Manager_v.1.2.xls” if you have not already done so. Take
a moment to read the instructions in the first (Instructions) worksheet and then
familiarize yourself with the content and layout of the other pages. You will be using this
workbook to store simulation results from your various analyses that you decided upon in
Sep One.
Steps 2 - 8 are for creating the baseline for each analysis.
Step 9
outlines carrying out the “What-if..?” types of analysis in your plan.
Step 10
outlines carrying out an “Apply strategy” type of analysis.
Steps 11-14 are for carrying out a Parametric analysis
Steps 15-16 Summary of findings and conclusions and submitting of deliverables
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STEP 2:  In Sketchup, open your shoebox model, verify, location, building and construction types
and make any necessary adjustments. Note that the construction settings you choose will be those in
your “base” model simulation. After that it will be simpler and quicker for you to make any desired
changes in IES VE Pro Click on the Launch VE tool. This is the red and green button with “VE”
written on it. This will launch VE and export your model.
STEP 3:  Set up your views. When the VE screen opens you should see a plan view of your model.
In the model navigation toolbar at the top there is a view selection pull-down menu. Select the
Axonometric view and make sure that the geometry imported correctly. Make sure that all the floors
and rooms are visible in the axon view of your model. Next, select the “View” menu at the top of the
screen to see that the Browser view is turned on (checked). If necessary select “Browser” to turn on
that view. If desired, you can set up multiple viewports for viewing your model. This may not be a
good idea unless you have a large monitor screen.
STEP 4:  Click on the Suncast tool icon and run a solar shading/irradiance analysis.
A. From the Calculations Menu in the menu bar, select “Solar Shading for Apache.”
B. In the window that opens the default settings should be from – January to December. If so
accept all the default settings and click on the “Start” button.
C. Save as your baseline model under the File Name “Team_-thermal-envelope” or similar.
**Note you do not have to run a Suncast Shading study again unless your windows or shading
elements change or unless you make changes to your model in Sketchup and relaunch IES. I.e., this
would be necessary if your analysis were to explore the effects of changing the south facing glass
area or WFAR or exterior window shades or overhangs, etc.
STEP 5:  Click on the Apache tool icon and run a “Dynamic Energy Simulation.” In the Apache
Simulation window take the following actions:
A. Change the title of the results file to “envelope study1-base.aps.”or something like that.
B. Set Simulation Dates:
a. From 1
January.
b. To
31
December
C. Click on “Simulate” button to run simulation.
STEP 6:  Select the results options to be displayed. You are currently in Vista. Click anywhere in
the model window and then click on the “Energy” button just below the model window. To the right
you will see a list of reporting options. While holding down the “Ctrl” button on your keyboard,
select 7 items from this list in this order.
A.
B.
C.
D.
E.
F.
G.

Boilers energy
Chillers energy
Ap Sys Aux + DWH/solar pumps energy
Ap Sys heat rej fans/ pumps energy
Total lights energy
Total equip energy
Total energy

**Note: This is important because the order of selection will determine the order that the results are
arranged and Excel expects the results table to be organized in a certain order.
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STEP 7:  Create the results table for copying to Excel.
A. From the menu bar at the top of the screen, click on the Analysis Menu and select “Monthly
Totals.” You will see the results table in a window on your screen.
B. At the top of the table select the Copy icon (third one from left) to copy the entire table.
C. Switch to MS Excel application. (Note: if you are running IES on a Mac in Parallel you
should be able to switch to MS Excel running in your Mac OS at this point.)
STEP 8:  Transfer results data to your Base Worksheet:
A. Click on the “Base” worksheet tab at the bottom of the window and paste the results data
from the base model simulation into Cell A1. It should completely replace the dummy data
that is in the table.
B. Save your Workbook file under a new name such as “Team __Envelope Optimization
Study 1” or something that you will recognize later.
STEP 9: Set up your first “What if” analysis simulation:
A. Determine whether to make changes to your sketchup model and start again in IES or return
to IES and make the necessary changes to the Base model you have already created there. If
you make changes to your sketchup model you will have to Exit IES before launching a new
simulation from Sketchup. You will also have to re run the Suncast Shading calculation as in
step 4 above. It is recommended that your first analysis be something you can change in your
IES base model. The following steps apply in that case. If you are planning to return to your
Sketch up model you can skip to step 10.
B.  Return to your IES VE Pro application. We’ll say that you are doing a “What-if?”
analysis on R 100 Superinsulated Walls. To run this simulation, you would make changes to
your Exterior Walls constructions as follows:
a. Close data table if it is still open.
b. Click on the Apache Tool Icon at left.
c. Select all of the rooms that are above ground in your model from the browser at the
lower left hand side of the screen.
d. Click on the Edit menu at the top of the screen and select “Selection
Set/Constructions.”
e. First select the Category: External Wall.
f. Next select the Construction Type to replace: select your base model default
construction type (most likely the second line.) You should see all the walls
highlighted.
g. Click on the “APcdb” button to bring up a list of all the available exterior wall
constructions.
h. You are going to create a custom wall based on your current wall construction. To do
this, hold down the Contrl key and click on the 5th tool icon from the Left, “Add
default Construction.”
i. At the bottom of the list you will find the new construction you created. Double click
on it.
j. There should be an insulation layer in this construction – double click on the
thickness value and change it to 16”. This should give you a revised u-value (see at
lower right) of around 0.01 (R100) if not change the thickness until you get
something close to 0.01. Click OK. Note the name of the new wall construction.
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C.

D.
E.
F.

k. Close the window and click YES to save changes.
l. Your new construction should be the first in the Possible Replacement Construction
Types. Select it and click the “Replace” button.
m. Close the window and return to Apache.
n. You have now changed your Exterior walls to R 100 or 0.01 u-value.
Run an ApacheSim (Dynamic Simulation):
a. Click on the ApacheSim (Dynamic Simulation) button at the bottom of your screen.
b. In the window that opens, give the results file a new name, e.g., replace the word
“base” with “R100”.
c. Make sure that the SunCast Link is checked.
d. Check the simulation dates (to be for a full year.) If they are click on the “Simulate”
button.
To get the results repeat the instructions from steps 6-7 above.
Transfer the results data into your Excel data manager workbook – Option 1 by following the
instructions in step 8.
Compare the results from the base model simulation and those in the R100 wall simulation. Is
the energy use lower? Is it as much as you expected? Why or why not?

Congratulations! You have completed your first “What if…?” analysis.
STEP 10:  Run your first “Apply strategy” analysis. In Sketchup, return to your shoebox model.
We will consider how you might add or change the window shading to your model:
A. Create shading for your South Facing Windows
a. Draw shading devices for all of your south facing windows in Sketchup. A rule of
thumb for 44 deg. N latitude is that the projection of the shade or overhang should be
equal to ½ the window height.
b. Group the overhangs and using the “select groups” tool – assign these objects as
“Shade” in your model.
c. Or…as an alternative – you may use the Salovich “Shoebox Plugin.” Make an
identical shoebox model and in the plugin dialog box, select yes for shading, generate
the model, copy and paste the shade group into your previous shoebox model and
reset the construction types and building type if necessary. Using the “select groups”
tool – assign these objects as “Shade” in your model. Run the Identify Rooms tool
and save your Shoebox model.
B. Click on the Launch VE tool. This is the red and green button with “VE” written on it. This
will launch VE and export your model.
C. Repeat steps 4-7.
D. Transfer the results data into your Excel data manager workbook – Option 2 by following the
instructions in step 8.
E. Compare the results from the base model simulation and those in the South Window Shading
version of your shoebox model. Is the energy use lower? Is it as much as you expected? Why
or why not? How do these results campare to the “What if…?” analysis you performed in
Step 9? Do the results seem reasonable? Which of the two simulations performed thus far
have produced the most favorable results? What other conclusions can you draw from the
analysis you have done so far?
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Congratulations! You have completed your Second simulation.

STEP 11: Begin your first Parametric Study. We will consider how you might optimize the exterior
wall insulation values for your shoebox model using the parametric analysis method:
A.  Open the Excel Excel workbook entitled: “2011-WBA-Parametric-DataManager_v.1.2.xls”. Save the file under a new name such as: “Team_wall-opt-study1.xls” or
something similar. Select the Instructions Tab and scroll down to the section titled:
“Parametric Study Optimization Plan.” In line 36 you will see the parameters set for a wall
optimization study simulating a range of u-values for exterior walls ranging from 0.10-0.017.
If you wish to change these values do so now.
Note: if you are doing a different optimization study, enter the appropriate values in each of
the fields in Line 36. These values will transfer to the appropriate locations in the subsequent
worksheets of the workbook.) However, only the values in Parametric Study 1 (line 36) will
transfer, so the current parametric study must be the first in the series of studies listed in your
plan.
B. Generate the Base energy performance data for your study by following Steps 2-8 above or
simply copy the base results data from an ealier Excel Workbook to avoid repeating these
steps.
STEP 12: Run the first simulation iteration of your first Parametric Study.
A.  Return to your IES VE Pro application. Perform the first iteration of your parametric
study as follows:
a. Close data table if it is still open.
b. Click on the Apache Tool Icon at left.
c. Select all of the rooms that are above ground in your model from the browser at the
lower left hand side of the screen.
d. Click on the Edit menu at the top of the screen and select “Selection
Set/Constructions.”
e. First select the Category: External Wall.
f. Next select the Construction Type to replace: select your base model default
construction type (most likely the second line.) You should see all the walls
highlighted.
g. Click on the “APcdb” button to bring up a list of all the available exterior wall
constructions. You can follow one of two alternative paths at this point. 1) Either find
a pre-defined wall construction that has the u-value you need for your Max. condition
and make a note of that wall designation (in the left hand column), or 2) create a
custom wall construction based on your current wall construction. Either option is
fine at this point. The following outlines the latter choice:
h. Create a custom wall based on your current wall construction to be the Max. u-value
condition. To do this, hold down the Contrl key and click on the 5th tool icon from
the Left, “Add default Construction.”
i. At the bottom of the list you will find the new construction you created. Double click
on it.
j. There should be an insulation layer in this construction – double click on the
thickness value and change it until the resulting “u-value” (lower right) is close to the
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value you require. When you have the value you are looking for - Click OK. Note the
name of the new wall construction.
k. Close the window and click YES to save changes.
l. Your new construction should be the first in the Possible Replacement Construction
Types. Select it and click the “Replace” button.
m. Close the window and return to Apache.
n. You have now changed your Exterior walls to have the u-value for your max.
condition.
B.  Run an ApacheSim (Dynamic Simulation):
a. Click on the ApacheSim (Dynamic Simulation) button at the bottom of your screen.
b. In the window that opens, give the results file a new name, e.g., replace the word
“base” with the appropriate description of the current simulation condition – e.g.,
“R10” might be your Max. condition.
c. Make sure that the SunCast Link is checked.
d. Check the simulation dates (to be for a full year.) If they are click on the “Simulate”
button.
C. To get the results repeat the instructions from steps 6-7 above.
D.  Transfer the results data into your Excel data manager workbook – Option 1 by
following the instructions in step 8.
STEP 13: Run the remaining iterations of your Parametric Study by repeating Step 12 as many times
as necessary to complete all of the iterations and reach the Min. u-value condition for your study.
STEP 14: Evaluate the results of your parametric study:
A.  In your Excel workbook, click on the Base worksheet tab. Look at the various
predefined charts in this worksheet that display the results of all the iterations of your study.
Take special note of the line charts for the various performance metrics and look at the
shapes of the curves. Can you determine from these charts the optimal condition?
B. You may wish to adjust the axis formatting for some of the line charts so as to get a more
pronounced curve. If you are not familiar with how to do this consult the help features in MS
Excel for the “Format Axis” command. Generally speaking the Minimum value of the
vertical axis can be adjusted to get a more pronounced curve in some cases.
C. Compare the results from the various simulations in your study. When was the energy use
lowest? Is there an indication that changing the u-value has a diminishing return? What
appears to be the optimal u-value for the exterior walls in your shoebox model? Does the
lighting and equipment energy use change or stay constant? Why or why not? How do these
results compare to the “What if…?” and “Apply strategy” analyses you performed in Steps 9
and 10? Do the results seem reasonable? Which of the three analyses performed thus far have
produced the most favorable results? What other conclusions can you draw from the analysis
you have done so far?

STEP 15: Meet with your teammates and review the findings of all your various analyses.
Summarize your findings and conclusions. In your own words summarize the results of the analyses
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completed by your team thus far. Include a short narrative (roughly 75-100 words) and at least 4
general conclusions that can be drawn. E.g., you might address the following questions:
1. Of the analyses performed which produced the most favorable results? How much
energy use reduction was achieved in this case in terms of % of base energy use? Do
you think this result can be achieved cost-effectively?
2. What recommendations would you make based on the “What if…?” and the “Apply
Strategy” analyses? Should these strategies be employed or not?
3. What are the optimal design conditions based on your combined parametric analyses?
4. If all of the strategies you recommend were adopted, what would be the potential
energy use reduction in toal energy consumption from your base model? What
percentage of energy use reduction relative to the base model?

Step 16: Deliverables: Upload the following deliverables to the Exercise 2 Drop Box on the
course Moodle Website by Thurs Oct. 13 at 12:30pm:
1. Summary and Conclusions in .pdf or .doc file format Include your name, date, course and
exercise no.
2. Submit your Excel Workbooks (there should be at least 2) with all of the results data
pasted into various worksheets. Include your Name and Project. Be sure that the text size
and color is appropriate and that all columns are formatted and any graphics are
positioned in the worksheets so that the data can be read.
3. Submit a 3D (axonometric) graphic representation of your Proposed Shoebox Building
with the south facing orientation in view.

GRADING CRITERIA - Exercise 2: 100 possible points (10% total of grade) based on the
following criteria:
•
•
•
•
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Completeness of deliverables submitted
Depth of analysis and complexity of project (shoebox.)
Clarity and accuracy of quantitative analysis charts and graphics
Clarity and accuracy of conclusions drawn

